
ZNOTES.ORG

SUMMARIZED NOTES ON THE PRACTICAL SYLLABUS

ICT (0417)
CAIE IGCSE
UPDATED TO 2019 SYLLABUS



1. Document Production

1.1. Word Processing (MS Word)

Serif – with flicks e.g. Cambria
Sans-serif – without flicks e.g. Calibri
One part of document as 1 column and the rest in two
columns a →
section break.
When you want to move text to the next column a →
column break.
To force all further text onto the next page → page break
A widow= single line that appears on the next page or
column,
separated from the rest of the paragraph
An orphan = single line that appears on the previous page
or column,
separated from the rest of the paragraph.
To add page numbers in the header/footer ------→ Place
your cursor where you want to put the number → Go to
insert tab → Quick parts → Select Numbering category
→ Select Page in field names → Click Ok
Add the file size/name (including file path) → click on
Quick parts in
Insert tab → click on Field → select File Size
or File name. For file
path → check the box to include file
path. For file size → choose
whether Kilobytes or
Megabytes.
Include date → click on Date & Time in Insert tab →
choose an
appropriate format as specified. (If the
date/month format is
flipped → change your region/
language settings on your computer to
United Kingdom.)
Update fields if required (select auto update while
inserting
fields.)

2. House Styles
Remember to follow all the instructions given, to avoid
losing easy
marks
Type in the name of the style exactly as it is in the paper
Click on the drop-down arrow in the Styles section →
select create a
new style
Always base your styles on the Normal font
Setting the line spacing → click on format → then
paragraph → select
required options
From the same tab, you can change the spacing before
and after the
paragraph
Setting all capital letters → click on format → font → tick
the option All
Caps




To set certain bullet to a list style → click on format →
click on
Numbering → Bullets tab → choose required
option
To indent text for a style → click on format → Paragraph
and input
required indents under the Indentation section.
Choose hanging
indents to indent the whole paragraph,
and first line indents to
indent only the first line of a
paragraph.

3. Mail merge
Create a master document, which is mostly given as a
source file
In the master document, click on the Mailings tab
In the start mail merge section, click on select recipients
→ select
use an existing list → choose source file
Select records to be used, filter if necessary




Insert merge fields where indicated with chevrons, i.e.
<Field>
Place automated current date and/or time, as well as
your name,
centre number and candidate number where
specified. Ensure date is
in the correct format specified.




Spell check and proof read the document.
Save the master document, and click finish and merge.
Preview
results and ensure that they look as required.
While printing:

check all merge fields are placed
field codes are visible if necessary. (Go to Advanced
settings
so they are displayed when printing. Proof of
date inserted may
be asked, right click and toggle field
codes or just use the
shortcut Alt+F9.)
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4. Data Manipulation
While importing files, make sure you select text file and
not excel
file, as .csv files are plain text.
When they ask for a set number of decimal places in a
field, choose
Fixed in Format.

Ensure that the dates displayed in the table are in the
correct
format under Table Design view.

To form a relationship between two tables, go to the
Relationships section of the Database Tools tab and
choose the required tables.

The calculations will ONLY work if placed in the report
footer.
If Σ Total is used this then it apperars
automatically in the report
footer.

Count number of fields in a
report

=COUNT(\[Primary_field\])
Always use primary field as it

is the only unique field

Sum of fields in a report =SUM(\[Field_name\])

Average of fields in a report =AVG(\[Field_name\])

Minimum of fields in a report =MIN(\[Field_name\])

Maximum of fields in a report =MAX(\[Field_name\])

) |
| Yes | Find values that are Yes/True |
| No | Find values
that are No/False |
| #01/01/2009# | Find a specific date |
|
>01/03/2009 | Find dates after a given date |
| <01/03/2009
| Find a date before a given date |
| Between 01/03/2009
and 31/03/2009 | Find dates in a given range |

5. Presentation Authoring (MS
PowerPoint)

To open a given outline, click “New slide” arrow and click
“slide
from outline...”
Printing presenter notes, click print “Notes pages"
Printing audience notes, click print “Handouts”
When printing evidence of slide transitions, go to slide
sorter and
then PrntScr
For all bullets to enter the screen at once → click on the
Custom
Animation under the Animations tab → Then
select all the bullet points
and Add Effect in the side pane
and choose the required style.




For the bullets to enter the screen one by one → Select
the first
bullet point and animate as required from Add
Effects. Repeat for
the remaining points.




When printing evidence of animations, open the Custom
animations
pane and then PrntScr
To show evidence of transitions, take a screenshot of the
slides
pane, having a star beside the slides that have
transitions.
To loop a slide show so it plays continuously until the Esc
key is
pressed. Under the Slide show tab, click on Set Up
Slide Show under
Set Up. It is in the Show options section
of the option box that
appears.
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6. Data Analysis
Naming a range of cells → select the cells → right click
and select
‘Name a Range’. → type the name in the option
box. Ensure the range
is correctly selected.

While printing spreadsheet:
check the fields required to show
if they want it showing formulae. (To show formulas
instead of
values, select Show Formulas under the
Formula Auditing section
of the Formulas tab.)

To set a cell as currency → click on the popup box in the
Number
section of the Home tab → select Currency and
pick the required symbol
and number of decimal places
as specified on the paper.

To colour a range of cells that contain certain values →
under Styles
section in the Home tab → click on the drop-
down menu under
Conditional Formatting. Choose New
Rule → Format only cells that
contain. → add the rule
according to the instructions on the paper
from the
Format tab (ego: less than 100, format: green). You can
add
more than one rule to a range of cells, by repeating
the same steps
for the new rule.

When you are using another file as a source file (ego for a
LOOKUP
function), make sure it is open until the end, else
the spreadsheet
will no longer be able to access that
data.

To make cell reference absolute, press F4 while
highlighting it

DESCRIPTION FORMULA

Add, Subtract, Multiply,
Divide

=A1+B1
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DESCRIPTION FORMULA

SUM = Adding a range of
numbers

=SUM(A1:A4)

AVERAGE - Find the average =AVERAGE(A1:A4)

MIN - Find the low value =MIN(A1:A4)

MAX - Find the highest value =MAX(A1:A4)

COUNT - Finding how many
numbers are in a range

=COUNT(A1:A4)

COUNTA - Counting the
number of items in a range

=COUNTA(A1:A4)

INT - Converts to the lowest
whole number

=INT(A1)

ROUND - Rounding numbers
=ROUND(A1,2) The 2 is the
number of decimal places

ROUNDUP - Rounding
numbers up

=ROUNDUP(A1,2) The 2 is the
number of decimal places

ROUNDDOWN - Rounding
numbers down

=ROUNDDOWN(A1,2) The 2 is
the number of decimal places

VLOOKUP - Looking up what
particular values mean from

a table arranged vertically

=VLOOKUP(A1,$B$1:$C$8,2)A
1 is the cell to

check$B$1:$C$8 is the array
to look in2 is column 2

from $B$1:$C$8 meaning
return the value in column 2

in that section.

HLOOKUP - Looking up what
particular values mean from
a table arranged horizontally

=HLOOKUP(A1,$B$1:$G$2,2)
A1 is the cell to

check$B$1:$G$2 is the array
to look in2 is row 2

from $B$1:$G$2 meaning
return the value in row 2 in

that section.

SUMIF – adding up specific
values in a range

=SUMIF($B$1:$C$8,A1, $D$1:
$D$8)Checks if any cells

in $B$1:$C$8 = A1 and if they
do then it adds them

together

COUNTIF - Counts the
number of cells in a range

that satisfy the given criteria

=COUNTIF(A2:A4,">4") Checks
that cells have a value greater

than 4=COUNTIF(A2:A4, A1)
Checks that the cells are

equal to the value in cell A1

IF – Deciding what will go into
a cell

=IF($B$1:$B$8=A1,”A”)IF the
value in A1 appears in the
range of cells then write A

Nested IF

=IF($B$1:$B$8=A1,”A”,
IF($B$1:$B$8=A2,”B”,

IF($B$1:$B$8=A3,”C”,D)))IF
the value in the range equals
A1 then write A, if it equals A2
write B, A3 write C and none

of them D

DESCRIPTION FORMULA

Average IF – it searches for
criteria and makes an
average of the range

according to the criteria

=AVERAGEIF($D$4:$D$64,G3,
$E$4:$E$64)$D$4:$D$64 is

the range, G3 is the
criteria, $E$4:$E$64 is the

average range

SQRT – Square root of a
number

=SQRT(B3)B3 is the number

7. Website Authoring (HTML)

7.1. HTML

Anchors: help navigate throughout a webpage
Highlight the destination of the anchor, and set a
bookmark
You can use
tags in your code around this text
<div id="top"> Destination text </div>
Highlight the word or image that will be the hyperlink,
and click
insert hyperlink and type the address of the
website or the bookmark
or the email address
provided in the respective places.


If the link needs to open in a new window select New
Window from
target frame. This will give you a target
setting of "_blank"

If there are specified dimensions for a table, use the table
properties to set these values.
Check the code to ensure that the table is not set to 100%
width, if
there are other values given.
To hide bullets from your webpage, add hidden after your
tag
selector.

Font type
h2 {font-family: “Times New

Roman”}

Text size h2 {font-size: 16pt}

Aligning text h2 {text-align: center}
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Font type
h2 {font-family: “Times New

Roman”}

‘Bold’ text h2 {text-weight: bold}

‘Underline’ text h2 {text-decoration: underline}

Second choice of font
h2 {font-family: “Times New

Roman, Verdana”}

Adding generic fonts
(either serif or sans-serif)

h2 {font-family: “Times New
Roman, serif”}h2 {font-family:

“Calibri, sans-serif”}

Changing colour h2 {color: #000000}

Using classes to set styles.
Can be used for many

selectors
right {text-align: right}

Comment in HTML - text
that is not read by the

computer, only for users

Comment in CSS - text
that is not read by the

computer, only for users
/* Enter comment here */

Colour codes have three parts:

(RED, GREEN, BLUE)
Amount of Light (colour) Hex code

Fully on FF

¾ on C0

½ on 80

¼ on 40

Off 00

Examples:
Pure red is (FF0000)
Pure green is (00FF00)
Pure blue is (0000FF)
Pure yellow is (FFFF00)
Pure black is (000000)
Pure white is (FFFFFF)

HTML tag <html></html>

Opening/closing head tag <head></head>

Page title
<title>HTML

REFERENCE</title>

Attaching a CSS file
<link rel=“stylesheet”

type=“text/css”href=“mystyle.
css”>

Defining anchor tag <a name=“top”></a>

Setting default target window <base target=“_self”>

Opening of the body/content <body></body>

Table tag | border width as 1
| alignment center

<table border=“1”
align=“center”></table>

7.2. CSS

What is CSS?

Cascading style sheet
Used to style webpages
2 types

Embedded/inline
External

 

Embedded

Used to apply style properties within html sheet
Format:

…style = “attribute: specification”>
Inline CSS for e.g. <table border=”1”
style=
“width:200px”>

To add several attributes, add semicolon to separate and
then use
same format

For e.g. < table style=
“width:29%; margin-left:
auto**;**”>

For inline CSS adding -style= “….”- is mandatory.

 

External

External CSS sheets are separate sheets that style the
webpage.
To use the are required to be attached to the main html
file using
the tag:

<link rel=“stylesheet” type=”text/css”

href=”sourcefile.css”>
Tag is placed in head tag of html file. Several html
sheets can
be attached.
Preference given to sheet placed last in head tag

Format for external CSS
h1 { property: value ;}
for e.g. h1 { color:#000000;}

↑ Element source taken from html script linked

 

CSS Tags

Colours

Colours can be in hexadecimal
hashtag before the hexadecimal is mandatory
e.g. #000000
F full capacity
0 is least capacity

Some colours can be written in words. Such as black or
white.

Fonts

Fonts are given priority from first to last in order
To add multiple fonts, add commas.
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Eg. h1 { font-family: Arial, Calibri, sans-serif;}

Tables

Tables have many attributes to help style them
Cell padding : creates space between text and cell
border
Cell spacing: creates space between individual cells
Borders
Background color: background tags in the tables only
apply to
the tables.

Individual td or th headings can also be specified in css

Table tags format

cell padding Table { padding :40px;}

cell spacing Table { spacing : 30px;}

borders

Table { border-width:3px;}
Table { border-color: #000098;}

Table { border-style: solid;}
Table { background-color: #009499;}

Td/th tags
td { font-size: 3;}

td { font-family: Calibri;}
td { color: #000000;}

Dimesnions
table { width:50px;}
table { height:60px;}

body { background-repeat: no-repeat;}
body {background-position: top/left/right/bottom;}
h1 {text-align: left/right/top/bottom;}

8. Editing Images
To save a picture with 8 bit - colour depth save it as a gif

Open it in paint and save as
To compress the size of a picture open it in picture
manager

Edit picture
Compress pictures
Choose most suitable option

To change colour options of a picture use picture
manager

Edit picture
Colour

9. Answers to theory
questions

11.1 Explain why generic file formats are needed:
They can be opened by any software to access the
data on them.

11.2 Explain the need to reduce file sizes for storage or
transmission:

Smaller files upload and download faster than larger
ones and
thus are better for transferring data on the

internet and
between computers and other devices
like printers.

13 Explain why headers and footers are needed:
Headers and footers ensure each page has all the
required
information like the page numbers, company
logo and name etc. It
makes the document more
reliable, professional, and consistent,
as the
information appears on every page. This saves time
and
reduces errors as they are only typed once.

14 Explain what is meant by corporate branding/house
style:

It refers to a specific style of fonts and formats used in
the
making of ICT solutions by organisations.

14 Explain why consistent styles are required:
Consistent styles enable users to associate a
particular
organisation with a style. They look
professional.

15.1 Explain why the automated suggestions given by
spell check
software do not always give the correct
response:

Some words, e.g. proper nouns are not found in the
dictionary.
This makes spell checkers less efficient.
Names and places are
not identified by spell checkers

15.1 Explain why validation checks must be appropriate
to the data
that is being checked:

An inappropriate check can lead to error messages
and altered
data, as it may accept or reject wrong
data.

15.2 Describe the importance of accuracy and the
potential
consequences of data entry errors:

Accurate data ensures the results obtained by the
processing of
data is relevant, which is essential to the
usability of the
model

15.2 Define the term verification:
A way of preventing errors when data is copied from
one medium
to another

15.2 Describe visual verification:
Visual comparison of data entered with a data source
Checking for errors by comparing entered data on the
screen with
the data in the original document (not the
same as proof
reading)

15.2 Describe double data entry:

Entering data twice and comparing them either after data
has been
entered, or during the entry process.

15.2 Explain the need for validation as well as verification:
Validation only ensures that data entered is in the
accepted
format. Verification is needed to ensure that
the data entered
is correct. Data entered may be in
the right format but of the
wrong value. Or it may be
copied correctly but does not match
the criteria.

17.1 Explain why it is necessary to use page, section and
column
breaks, to adjust pagination and to avoid widows
and orphans?

Page breaks and column breaks help remove widows
and orphans, by
forcing text onto the next page/
column so it is all together.
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Does not disrupt reader by breaking the flow.
17.3 Explain why mail merged documents are created

Mail merged documents save time typing out
individual letters,
as they can be personalized by the
computer. Errors while typing
are also reduced, since
the master document is only typed once.
They can
also be sent by email using the address in the source
file.

18.1 Define the terms flat-file database and relational
database.

Flat-files databases are tables that have data sorted in
rows
and columns.
Relational databases are several tables linked
together,
preventing unnecessary repetition of data.

18.1 Explain that other field types such as placeholders
for media,
including images, sound bites and video clips
are used in commercial
databases

They are not studied in depth in this syllabus. They
are used in
web applications where a back-end
database holds the media to be
displayed in another
application such as a webpage.

18.1 Discuss the advantages and disadvantages of using
relational
tables rather than a flat file database

Relational Database Flat file Database

Better security Poor at complex queries

Cater for future
requirements

Poor at limiting access

Data is only stored once
Harder to update, so
inherently inefficient

Requires more planning Potential duplication

Easy to design

Non unique records

Harder to change dataformat.

18.1 Define and understand the terms primary key and
foreign key and
their role in a relational database.

Primary key: The key field of a table which is unique and
identifies
each record
Foreign key: The field linked to the primary field of the
table
linked to through a relationship

20.1 Define the terms: cells, rows, columns, sheets, tabs,
pages,
charts

Cell: A space for data to be entered a table; a box
formed by
the intersection of columns and rows.
Rows: Horizontal boxes that divide the table
Columns: Vertical boxes that divide the table
Sheets: A table of data
Pages: Divides a piece of data into sections
Tabs: A module of a database program that holds the
tables on
the computer
Charts: A graphical representation of (usually
tabulated) data

20.1 Explain the importance of accurate data entry in
spreadsheets

Ensures the results obtained by the processing of
data is
relevant, which is essential.

20.1 Define the terms: formula, function, absolute
reference,
relative reference, ranges, named cell, named
range, nested
formulae/functions.

Formula: are mathematical operators defined by the
user to
perform a function
Function: predefined logical and mathematical
operations a use
can use in a spreadsheet
Absolute reference: is made when the cell referenced
stays
constant but the cell referred to in is changing.
Relative reference: is made when the cell reference is
supposed
to change when the cell it is referred to in is
changing. It
aids more efficient designing of models.
Ranges: A group of cells in a table
Named cell: A cell in a table that is given a name (like
‘profit
margin’) and can be referred to using that
name in functions
Nested formulae/functions: A formula/function used
inside a
formula/function as an argument
20.1 Explain the difference between a formula and a
function
Formulas are typed in by the user. They include
simple
mathematical operators like +, -, *, or /, or can
be as complex
as the user wants. A function is
predesigned code that
calculates specific values, e.g.
MAX, VLOOKUP. While functions
can be used inside
formulas, formulas cannot be used inside
functions.

20.1 Explain the function of absolute and relative
referencing.

Absolute referencing is used when the cell referred
needs to
stay the same, even when the formula/
function is copied.
When a formula/ function is copied, and relative
referencing is
used, the cell referred to changes with
the cell that the
function is in.

20.2 Define the terms: testing, test data, expected
outcome, actual
outcome, normal data, abnormal data,
extreme data, what if

Testing: Checking that the designed model shows or
previews the
expected outcome when data is entered
Test data: The input data used for testing a model
Expected outcome: the output a model is supposed to
give with
the test data
Actual outcome: the output the model gives when
tested in real
time
Normal data: data within the given range ego: 50,
range: 0-100
Abnormal data: data outside the given range ego: 120,
range:
0-100
Extreme data: data that is the limit of the range ego: 0
or 100,
range: 0-100
What if: changing values in cells to see how outcome
of formulas
change

20.2 Explain the need to test a model before it is used
Reduces the number of possible errors when using
real data

CAIE IGCSE ICT (0417)

WWW.ZNOTES.ORG



21.1 Identify and describe the three web development
layers

Content layer: Holds the content of the webpage
structure.
Behaviour layer: scripting language of a web page or
an
individual element
Presentation layer: responsible for the formatting of a
webpage(s) or elements (using a stylesheet).

21.1 Understand the function of:
Content layer: enter the content of a web page
structure
Behaviour layer: enter scripting language to a web
page or
an individual element
Presentation layer: format whole web page(s) or
individual
elements

21.2 Explain why tables are used to structure elements
within a web
page

Tables make the basic structure of a webpage and
organise page
layout.

21.2 Define and understand the terms relative file path
and absolute
file path

Relative file path: A path referring to a file in the same
directory relative to the page the reference is made in.
Absolute file path: The full path of a file, which is not
relative to anything.

21.2 Explain why absolute file paths must not be used for
hyperlinks
to locally saved web pages/ objects

Absolute paths always include the domain name of
the website
These should not be used to refer to locally saved
webpages as
the computer the webpage is stored on
(the server) is not the
same as where the webpage
was developed, and an absolute file
path would point
to the wrong address.

21.3 Explain what is meant by the term cascading
stylesheets

CSS (cascading stylesheet) is a text-based language
which is
attached to webpages to set their format. CSS
files have a
“.css” extension

21.3 Explain the hierarchy of multiple attached
stylesheets and
in-line styles within a web page

Internal CSS have more preference over Inline CSS.
Inline CSS
overrides externally attached stylesheets.
If several external stylesheets are attached to one
web page,
the stylesheet attached last (at the bottom
of that part of the
code) is given preference (over the
other ones). Priority
increases as you go down a list.
21.3 Explain why relative file paths must be used for
attached
stylesheets
They should be attached using relative file paths as
they are
stored along with the webpage since they are
stored in the same
folder.

21.4 Explain how to upload and publish the content of a
website
using ftp

Used to upload website files to the web hosting space. To
upload
these files successfully, the user needs:

FTP client software
All files in one folder
Host Name/URL/IP address for ftp
Host port to be used for upload
Username and password

21.4 Create a test plan to test a website including: web
page
elements are visible, navigation within/from a web
page

Open webpage in different browsers to check that all
elements
appear the way they should.
Click all hyperlinks to ensure that they direct users to
the
correct pages, using functional testing. Check that
both
internal and external links are functional. Check
that fonts and
background colours are appropriate to
the purpose of the website
and its users (audience)
Perform user testing on a group from the target
audience, gain
feedback from their usage, and use it
to improve the website
before publishing it

21.4 Justify the choice of test plan
The test plan used to test a webpage must be justified
based on
the elements being tested. e.g. If hyperlinks
are being tested,
it checks if all the hyperlinks are
redirecting the user to the
correct webpage/ section
of webpage.
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